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1 Overview
“Setting File Creation Software for North America” creates a setting file to be used for the air-conditioning 
management system.
The created data file is uploaded to each system by using upload function.

CAUTION

"Setting File Creation Software for North America" and "Setting File Creation Software for North America" (UL-approved 
system) appeared on the screen shots in this manual are the names of a software represent the same software. 
However, some functions are restricted. Refer to the "Operating Instructions" for the details.

2 System Requirements
The following shows the ideal system requirements for this software.

The following runtime library is required:
• Microsoft® .NET Framework 2.0 SP2

• “Windows XP”, “Windows Vista”, and “Windows 7” are either registered trademarks or trademarks of Microsoft 
Corporation in the United States and / or other countries.

• Adobe, the Adobe logo, Reader, and Acrobat are either registered trademarks or trademarks of Adobe Systems 
Incorporated in the United States and / or other countries.

• InstallShield is either a registered trademark or trademark of Flexera Software Inc. in the United States and / or 
other countries.

• All other company and product names are either registered trademarks or trademarks of the respective owners. 
In this manual such names are not indicated by ™, ® or © marks.

Item Specifications

Operating System Windows XP with SP3 or later, Windows Vista, Windows 7

Office Office 2003, Office 2007, Office 2010
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3 Note on Using Setting File Creation 
Software for North America

Selectable outdoor units / indoor units differ depending on the frequency and region setting. The frequency of an 
already created file cannot be changed.

Fig.1 [Main Menu] screen (Frequency)

CAUTION

• [60 Hz - UL Model] must be selected on [Frequency and Region Setting] to use with UL-approved system (Model: 
BMS-SM1281HTLUL).

• Fire alarm function that described in this manual can not be used with UL-approved system (Model: BMS-
SM1281HTLUL).
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4 Creating a Setting File

Workflow of the Software
The following flowchart shows the process of creating data with Setting File Creation Software for North America:

Start Setting File Creation Software for North America

Create data Edit data

Select a file

Set up system data

Set up a server / interface

Set up outdoor units/indoor units/zone/demand

Select a system
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Data Upload
The following flowchart shows the process of uploading data created with Setting File Creation Software for North 
America:

Start Setting File Creation Software for North America

Start from the data input main screen Start from the main menu screen

Select setting file data

Upload

Select a setting file folder

Select a target system

Specify IP address

PING test

Restart to finish uploading
Check uploaded data and perform the trial operation
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5 Features of Setting File Creation Software 
for North America

Creating / Editing a Setting File
You can create a setting file and edit it.

Fig.2 [Main Menu] screen
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Selecting a North America
When creating a new setting file, select a target North America.

Fig.3 [Select System] screen

Creating / Editing Data of a Setting File

Setting Up System Data
Set up data of the entire system selected on the Select System screen (Fig.3)

Fig.4 [System] screen
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Setting Up a Server / Interface
Set up a server / interface. The Server / Interface screen consists of the Server Setting tab, the Interface Address 
tab, and the Interface Setting tab.

Fig.5 [Server / Interface] screen
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Setting Up Outdoor Units
Set up data of outdoor units.

Fig.6 [Outdoor] screen
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Setting Up the Zone
Set up the zone. The Zone screen consists of the zone combo box and zone name list.

Fig.7 [Zone] screen
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Setting Up Indoor Units
Set up data of indoor units.

Fig.8 [Indoor] screen
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Setting Up the Demand
Set up the demand alarm input of indoor units. This setting is only available for Smart Manager.

Fig.9 [Demand] screen

Setting Up the Zone Names
Set up the zone names. This setting is only available for Smart Manager.

Fig.10 [Set tree count and name] screen
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Checking the Version Information
Select the [Help] menu then [About] to display the version information.

Fig.11 [Help] menu (About)

Fig.12 [About] screen
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Uploading a Setting File to the Server
Specify a setting file data, its folder, the target system and IP address, then upload the file.

Fig.13 [Upload Settings] screen

The following screen is displayed during upload to show the upload progress screen.

Fig.14 [Upload Progress] screen
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6 Compliant Manager / Smart Manager

Using the Setting File Creation Software for North America

Starting / Exiting the Setting File Creation Software for North America

Starting the Setting File Creation Software for North America
Use the desktop icon or Windows menu to start the Setting File Creation Software for North America.

1. Start the Setting File Creation Software for North America.

• Desktop icon 
Double-click the desktop icon.

Fig.15 Setting File Creation Software for North America desktop icon

• Windows menu 
Select [Start] > [All Programs] > [Toshiba] > [Setting File Creation Software for North America].

2. The startup screen appears.
The startup screen appears.

Fig.16 Startup screen

3. Data Download Software for North America Startup Complete
The startup screen (Fig.16) disappears, and the Main Menu screen (Fig.2) appears. The Setting File Creation 
Software for North America startup is now complete, and the software can be operated.
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Exiting the Setting File Creation Software for North America
Click the [Close] button, the Exit button, or select the [File] menu then [Exit].

Fig.17 [Main Menu] screen (Close button)

Fig.18 [Main Menu] screen (Exit button)

Fig.19 [Main Menu] screen (Exit menu)

The exit confirmation dialog box appears.
Click [Yes] to exit, or [No] to cancel exiting.

Fig.20 Exit confirmation dialog box

Click button

Click button
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Creating New Data
Click the [New] button, or select the [File] menu then [New]. The Select System screen (Fig.3) appears.

Fig.21 [Main Menu] screen (New button 1)

Fig.22 [Main Menu] screen (New button 2)

Fig.23 [Main Menu] screen (New menu)

Click button

Click button
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Selecting a File to Edit Data
Click the [Select File] button, or select the [File] menu then [Open]. The Open screen appears.

Fig.24 [Main Menu] screen (Select File button)

Fig.25 [Main Menu] screen (Open button)

Fig.26 [Main Menu] screen (Open menu)

Click button

Click button
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When the Open screen has opened, select a file to edit. The System screen (Fig.4) appears.

Fig.27 [Open] screen
– 22 –
 22-EN



Setting File Creation Software for North America Operating Instructions
Using a History File to Edit Data
Double-click a line in the History List, or select a file from Recently Used File. The System screen (Fig.4) appears.

Fig.28 [Main Menu] screen (History List)

Double-click
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Up to 9 files are stored in Recently Used File.

Fig.29 [Main Menu] screen (Recently Used File)

If the selected file does not exist, a warning appears.

Fig.30 Warning message box
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Setting Up the System
Select the [System] tab and configure the settings.

Fig.31 [System] tab

The following table shows how to enter / select data:
Compliant Manager, Smart Manager

Table.1 How to enter / select data

CAUTION

Fire alarm function that described in this manual can not be used with UL-approved system (Model: BMS-
SM1281HTLUL).

Item Data type Selection Note
Building name Entered by user —
Built-in controller fire alarm 
channel Selected by user Select from list Smart Manager only

Indoor unit total Q'ty Entered by user Numeric value only
Daily report closing time Entered by user Time only
Monthly report closing date Entered by user Numeric value only
Lock Linkage Mode Selected by user Select from list Smart Manager only
Date display format Selected by user Select from list Smart Manager only
Starting day of the week Selected by user Select from list Smart Manager only
Energy Monitoring Selected by user Select from list
Stand-by power counting Selected by user Select from list
Words in error code definition file Selected by user Select from list Compliant Manager only
Words in error code definition file 
and zone name tags Selected by user Select from list Smart Manager only

Temperature display: Interval Selected by user Select from list
Temperature display: C./F. Selected by user Select from list
Support Information Entered by user —
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Setting Up the Server
Select the [Server Setting] tab under the [Server / Interface] tab, and configure the settings.

Fig.32 [Server Setting] tab

The following table shows how to enter / select data:
Compliant Manager, Smart Manager

Table.2 How to enter / select data

Item Data type Selection Note

IP Address Entered by user Numeric value only

Subnet Mask Entered by user Numeric value only

Default Gateway Entered by user Numeric value only

Digital I/O Relay Interface Q'ty Entered by user Numeric value only 0 - 4

Energy Monitoring Relay Interface 
Q'ty Entered by user Numeric value only 0 - 4
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Setting Up the Interface Address
Select the [Interface Address] tab under the [Server / Interface] tab, and configure the settings.

Fig.33 [Interface Address] tab

The following table shows how to enter / select data:
Compliant Manager, Smart Manager

Table.3 How to enter / select data

Item Data type Selection Note

Energy Monitoring Relay Interface 
Address Data Entered by user Numeric value only

Digital I/O Relay Interface Address 
Data Entered by user Numeric value only
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Setting Up the Interface Function
Select the [Interface Setting] tab under the [Server / Interface] tab, and configure the settings.

Fig.34 [Interface Setting] tab

The following table shows how to enter / select data:
Compliant Manager, Smart Manager

Table.4 How to enter / select data

Item Data type Selection Note

I/O Function Selected by user Select from list

Signal logic Selected by user Select from list Digital I/O Interface Only

Pulse constants Entered by user Numeric value only
0.1 – 99.9, Energy 
Monitoring Relay Interface 
Only
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Adding an Outdoor Unit
Click the [New] button, or select the [Operation] menu > [Outdoor Unit] > [New]. A line will be added to the outdoor 
unit list.

Fig.35 [Outdoor] tab (New button)

Fig.36 [Outdoor] tab (New menu)

The following table shows how to enter / select data:

Compliant Manager, Smart Manager

Table.5 How to enter / select data

Item Data type Selection Note

LINE No Selected by user Select from list

Line address Entered by user Numeric value only

Outdoor unit combination model 
name Selected by user Select from the Select 

outdoor unit model screen

Outdoor unit model name Cannot be edited

Outdoor name Entered by user

Outdoor unit address Cannot be edited

Power meter input name Selected by user Select from list

Click button
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Selecting an outdoor unit
Clicking a cell of an outdoor unit combination model name on the [Outdoor] tab (Fig.6) displays the Select outdoor 
unit model screen. On the screen, double-click a cell of an outdoor unit model, or select a model then click the OK 
button. "Outdoor unit combination model name," "Outdoor unit model name," and "Outdoor unit address" will 
automatically become available on the [Outdoor] tab (Fig.6). To cancel changing the outdoor unit setting, click the 
Cancel button to return to the [Outdoor] tab.

Fig.37 [Select outdoor unit model] screen
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Copying the Data of an Outdoor Unit
Select a line of an outdoor unit on the [Outdoor] tab (Fig.6), and click the [Copy] button, or select the [Operation] 
menu > [Outdoor Unit] > [Copy]. The copied outdoor unit will be added to the outdoor unit list. The numbers of the 
copied “Line address” and “Outdoor name" will automatically be increased in one.

Fig.38 [Outdoor] tab (Copy button)

Fig.39 [Outdoor] tab (Copy menu)

Click button
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Copying the Data of Multiple Outdoor Units
Select a line of outdoor unit on the [Outdoor] tab (Fig.6), and click the [Multicopy] button, or select the [Operation] 
menu > [Outdoor Unit] > [Multicopy]. The Copy line count screen appears.

Fig.40 [Outdoor] tab (Multicopy button)

Fig.41 [Outdoor] tab (Multicopy menu)

Enter the copy count, then click the OK button. The copied outdoor units will be added to the outdoor unit list. The 
numbers of the copied “Line address” and “Outdoor name" will automatically be increased in one.

Fig.42 [Copy line count] screen

Click button
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Deleting the Data of Outdoor Units
Select one or more lines of outdoor units on the [Outdoor] tab (Fig.6), and click the [Delete] button, or select the 
[Operation] menu > [Outdoor Unit] > [Delete].

Fig.43 [Outdoor] tab (Delete button)

Fig.44 [Outdoor] tab (Delete menu)

The deletion confirmation dialog box appears.
Click the OK button to delete. The outdoor units will be deleted from the outdoor unit list. To cancel deletion, click 
the Cancel button.

Fig.45 [Deletion confirmation dialog box

Click button
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 Inserting an Outdoor Unit
Select a line of an outdoor unit on the [Outdoor] tab (Fig.6), and click the [Insert] button, or select the [Operation] 
menu > [Outdoor Unit] > [Insert]. A line will be inserted at the selected location in the outdoor unit list.

Fig.46 [Outdoor] tab (Insert button)

Fig.47 [Outdoor] tab (Insert menu)

Click button
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Editing a Zone
On the [Zone] tab, select a section (Floor, Monthly report tenant, Tenant, Area) from the combo box in the upper 
left corner of the window. Enter a name in the displayed zone list.

Fig.48 [Zone] tab (Floor)

Fig.49 [Zone] tab (Monthly report tenant)

Click
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Fig.50 [Zone] tab (Tenant)

Fig.51 [Zone] tab (Area)
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Adding a Zone
Click the [New] button, or select the [Operation] menu > [Tree] > [New]. A line will be added to the zone list.

Fig.52 [Zone] tab (New button)

Fig.53 [Zone] tab (New button)

The following table shows how to enter / select data:
Compliant Manager, Smart Manager

Table.6 How to enter / select data

Item Data type Selection Note

Name Entered by user

Tally Classifications Selected by user Select from list Monthly report tenant only

Monthly report tenant name Selected by user Select from list Tenant only

Click button
– 37 –
37-EN



EN

Setting File Creation Software for North America Operating Instructions
Copying the Data of a Zone
Select a line of a zone on the [Zone] tab, and click the [Copy] button, or select the [Operation] menu > [Tree] > 
[Copy]. The copied zone will be added to the zone list. The number of the copied “Name" will automatically be 
increased in one.

Fig.54 [Zone] tab (Copy button)

Fig.55 [Zone] tab (Copy menu)

Click button
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Copying the Data of Multiple Zones
Select a line of zone on the [Zone] tab, and click the [Multicopy] button, or select the [Operation] menu > [Tree] > 
[Multicopy]. The Copy line count screen appears.

Fig.56 [Zone] tab (Multicopy button)

Fig.57 [Zone] tab (Multicopy menu)

Enter the copy count, then click the OK button. The copied zones will be added to the zone list. The number of the 
copied “Name" will automatically be increased in one.

Fig.58 [Copy line count] screen

Click button
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Deleting the Data of Zones
Select one or more lines of zones on the [Zone] tab (Fig.7), and click the [Delete] button, or select the [Operation] 
menu > [Tree] > [Delete].

Fig.59 [Zone] tab (Delete button)

Fig.60 [Zone] tab (Delete menu)

The deletion confirmation dialog box appears.
Click the OK button to delete. The zones will be deleted from the zone list. To cancel deletion, click the Cancel 
button.

Fig.61 Deletion confirmation dialog box

Note that the following data will also be deleted if a zone is deleted:
• The Zone setting of an indoor unit set to the deleted zone

Click button
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 Inserting a Zone
Select a line of a zone on the [Zone] tab (Fig.7), and click the [Insert] button, or select the [Operation] menu > [Tree] 
> [Insert]. A line will be inserted at the selected location in the zone list.

Fig.62 [Zone] tab (Insert button)

Fig.63 [Zone] tab (Insert menu)

Click button
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Renumbering the Zones
Click the [Renumber] button, or select the [Operation] menu > [Tree] > [Renumber]. The numbers in the “No” 
column will be reassigned.

Fig.64 [Zone] tab (Renumber button)

Fig.65 [Zone] tab (Renumber menu)

Click button
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Changing the Order of the Zones
Select a line of a zone on the [Zone] tab, and click the [Up] / [Down] button, or select the [Operation] menu > [Tree] 
> [Up] / [Down]. The selected line moves up or down.

Fig.66 [Zone] tab (Up button)

Fig.66-1 [Zone] tab (Down button)

Fig.67 [Zone] tab (Up menu)

Fig.67-1 [Zone] tab (Down menu)

Click button

Click button
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Adding an Indoor Unit
Click the [New] button, or select the [Operation] menu > [Indoor Unit] > [New]. A line will be added to the indoor 
unit list.

Fig.68 [Indoor] tab (New button)

Fig.69 [Indoor] tab (New menu)

Click button
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The following table shows how to enter / select data:
Compliant Manager, Smart Manager

Table.7 How to enter / select data

CAUTION

Fire alarm function that described in this manual can not be used with UL-approved system (Model: BMS-
SM1281HTLUL).

Item Data type Selection Note

LINE No Selected by user Select from list

Line Address Entered by user

Indoor unit address Entered by user

Parent Indoor Unit No. Entered by user

Indoor unit model name Selected by user Select from the Select 
indoor unit model screen

R.C.group / indoor name Entered by user

Floor name Selected by user Select from list

Tenant name Selected by user Select from list

Area name Selected by user Select from list

Door-lock input name Selected by user Select from list

Fire alarm input name Selected by user Select from list

Power meter input name Selected by user Select from list

General purpose interface Energy 
Coefficient (kWh) Entered by user

Air Conditioner No. Entered by user
– 45 –
45-EN



EN

Setting File Creation Software for North America Operating Instructions
Selecting an Indoor Unit
Clicking a cell of an indoor unit model name on the [Indoor] tab (Fig.8) displays the Select indoor unit model screen. 
On the screen, double-click a cell of an indoor unit model, or select a model then click the OK button. "Indoor unit 
model name" will automatically become available on the [Indoor] tab (Fig.8). To cancel changing the indoor unit 
setting, click the Cancel button to return to the [Indoor] tab.

Fig.70 [Select indoor unit model] screen
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Copying the Data of an Indoor Unit
Select a line of an indoor unit on the [Indoor] tab (Fig.8), and click the [Copy] button, or select the [Operation] menu 
> [Indoor Unit] > [Copy]. The copied indoor unit will be added to the indoor unit list. The numbers of the copied 
“Indoor unit address" and “R.C.group / indoor name” will automatically be increased in one.

Fig.71 [Indoor] tab (Copy button)

Fig.72 [Indoor] tab (Copy menu)

Click button
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Copying the Data of Multiple Indoor Units
Select a line of indoor unit on the [Indoor] tab (Fig.8), and click the [Multicopy] button, or select the [Operation] menu 
> [Indoor Unit] > [Multicopy]. The Copy line count screen appears.

Fig.73 [Indoor] tab (Multicopy button)

Fig.74 [Indoor] tab (Multicopy menu)

Enter the copy count, then click the OK button. The copied indoor units will be added to the indoor unit list. The 
numbers of the copied “Indoor unit address" and “R.C.group / indoor name” will automatically be increased in one.

Fig.75 [Copy line count] screen

Click button
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Deleting the Indoor Units
Select one or more lines of indoor units on the [Indoor] tab (Fig.8), and click the [Delete] button, or select the 
[Operation] menu > [Indoor Unit] > [Delete].

Fig.76 [Indoor] tab (Delete button)

Fig.77 [Indoor] tab (Delete menu)

The deletion confirmation dialog box appears.
Click the OK button to delete. The indoor units will be deleted from the indoor unit list. To cancel deletion, click the 
Cancel button.

Fig.78 Deletion confirmation dialog box

Click button
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 Inserting an Indoor Unit
Select a line of an indoor unit on the [Indoor] tab (Fig.8), and click the [Insert] button, or select the [Operation] menu 
> [Indoor Unit] > [Insert]. A line will be inserted at the selected location in the indoor unit list.

Fig.79 [Indoor] tab (Insert button)

Fig.80 [Indoor] tab (Insert menu)

Click button
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Changing the Order of the Indoor Units
Select a line of an indoor unit on the [Indoor] tab, and click the [Up] / [Down] button, or select the [Operation] menu 
> [Indoor Unit] > [Up] / [Down]. The selected line moves up or down.

Fig.81 [Indoor Unit] tab (Up button)

Fig.81-2 [Indoor Unit] tab (Down button)

Fig.82 [Indoor Unit] tab (Up menu)

Fig.82-2 [Indoor Unit] tab (Down menu)

Click button

Click button
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Deleting All Air Conditioner No. of the Indoor Units
Click the [Clear] button, or select the [Operation] menu > [Indoor Unit] > [Clear]. All the Air Conditioner No. will be 
deleted.

Fig.83 [Indoor Unit] tab (Clear button)

Fig.84 [Indoor Unit] tab (Clear menu)

Click button
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Setting Up the Demand Alarm
Select the [Demand] tab, select a demand device, and set up the demand alarm.
The Compliant Manager setting cannot be changed.

Fig.85 [Demand] tab (Indoor)
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Setting / Canceling the Demand Alarm Input
The information of the indoor units appears in the Demand list. Select an control mode of the demand alarm from 
the combo box.

Fig.86 [Demand] tab (Control Mode selection)

Select one or more demand alarm input names.

Fig.87 [Demand] tab (Demand Alarm input name selection)
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Clicking the [Set] button sets the selected demand alarm names to the selected input mode.

Fig.88 [Demand] tab (Set)

Clicking the [Cancel] button sets the selected demand alarm names to "No setting."

Fig.89 [Demand] tab (Cancel)

The selected control 
mode is set

"No setting" is set
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Saving Created Data to a File
Click the [Save] button, or select the [File] menu then [Save Setting File] or [Save Setting File As].

Fig.90 [Save] button

Fig.91 [Save Setting File] menu

Fig.92 [Save Setting File As] menu

Click button
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When a new file is created or the menu [Save Setting File As] is selected, the [Save As] screen appears. Select a 
destination folder and enter a file name.

Fig.93 [Save As] screen

When the data is to be saved to an existing file, the overwrite confirmation dialog box appears. Click the OK button 
to overwrite the file. To cancel saving and return to the data input screen, click the Cancel button.

Fig.94 Overwrite confirmation dialog box
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Outputting a DEF File
Click the [Output File] button, or select the [File] menu then [Output DEF File].

Fig.95 [Output File] button

Fig.96 [Output DEF File] menu

The overwrite confirmation dialog box appears. Click the OK button to overwrite the file. To cancel saving and 
return to the data input screen, click the cancel button.

Fig.97 Overwrite confirmation dialog box

Click button
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The Browse For Folder screen appears. Select a destination folder to save the DEF file to.

Fig.98 [Browse For Folder] screen

The entered data will be checked. If the data contains an error, the item and error message box appear. Modify the 
section containing the error.

Fig.99 Example of error message box

When the DEF file output is complete, a message appears. Select the "Start up the upload screen." checkbox and 
click the OK button. The upload screen appears.

Fig.100 DEF file output complete dialog box
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Deleting a File History
You can delete a selected history item or all the history items.
• Delete Selected History
• Delete All

Fig.101 [Main Menu] screen (Delete History)

The deletion confirmation dialog box appears.
Click the OK button to delete. The history item will be deleted from the History List. To cancel deletion, click the 
Cancel button.

Fig.102 Deletion confirmation dialog box

This history item is deleted 
if [Delete Selected History] 
is selected
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Uploading a Setting File (DEF File)

Uploading a Setting File (DEF File)
Click the [Upload] button or select the [File] menu then [Upload] on the [Main Menu] screen (Fig.2) or [Data Input 
Main] screen (Fig.4). The Upload Settings screen (Fig.14) appears.

Fig.103 [Main Menu] screen (Upload button)

Fig.104 [Main Menu] screen (Upload menu)

Fig.105 [Data Input Main] screen (Upload button)

Fig.106 [Data Input Main] screen (Upload menu)

Click button

Click button
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Specifying Setting File Data
Specify the setting file data to upload.

Fig.107 [Upload Settings] screen (Specify file directly)

Select a file on the Open screen.

Fig.108 [Open] screen

Click button
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Specifying a Setting File Folder
Select a folder.
When setting file data is specified, the folder is automatically selected depending on the setting.

Fig.109 [Upload Settings] screen (Specify folder directly)

Select a folder containing the setting file on the Browse For Folder screen.

Fig.110 [Browse For Folder] screen

Click button
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Specifying a Target System
Select a destination system to upload the file to.
When setting file data is specified, the system is automatically selected depending on the settings.

Fig.111 [Upload Settings] screen (Target System)

Specifying an IP Address
Specify the IP address of the destination system.
When setting file data is specified, the address automatically appears.

Fig.112 [Upload Settings] screen (IP Address)
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The following table shows the items in the File List:

Starting the Upload
After the preparation (P61 to P64) has been completed, click the Upload button. The upload starts.

Fig.113 [Upload Settings] screen (Upload button)

The progress bar is displayed during the upload.

Fig.114 Progress bar

CAUTION

If Compliant Manager, Smart Manager or Touch Screen Controller is shut down during upload, stored data may be 
damaged and the controller may not operate.
Do not shut down the controller during upload.

Item Content

File Name Name of the file to upload

Size Size of the file to upload

Last Updated Last updated time of a file to upload

File
Shows whether a setting file exists in the specified folder
Yes: Exists
No: Does not exist

Click button
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System Settings

System Tab
The following table shows the settings configured on the System tab:

Compliant Manager, Smart Manager

CAUTION

Fire alarm function that described in this manual can not be used with UL-approved system (Model: BMS-
SM1281HTLUL).

Item Content Data type / range
Building name Building name Characters (Up to 20 bytes, Forbidden: > < " & \n ; ,)

Built-in controller fire alarm 
channel

Built-in controller fire alarm 
channel is used

(Smart Manager only)
0: N/A
1: Valid

Indoor unit total Q'ty Number of indoor units 1 - 128

Daily report closing time Time when the daily report 
is output 0:00 – 23:59

Monthly report closing date Date when the monthly 
report is output 1 - 31

Lock Linkage Mode Lock linkage mode pattern

0: Setting No.0
1: Setting No.1
2: Setting No.2
3: Setting No.3

Energy Monitoring Whether the energy 
monitoring is used

0: void
1: Valid (Distribution by capacity demand)

Stand-by power counting
Select the distribution 
mode of outdoor heater 
capacity

1: Proportional sharing on indoor unit horse power codes.
2: Equal sharing on indoor units Q'ty
3: Distribution of power consumption except compressor 

warmer to tenants.

Words in error code definition file 
(Compliant Manager only) Language of error codes

1: English
2: Chinese (Simplified)
4: Deutsch
5: Espanol
6: Francais
7: Italiano

Words in error code definition file 
and zone name tags 
(Smart Manager only)

Language of error codes 
and zone name tags

1: English
2: Chinese (Simplified)
4: Deutsch
5: Espanol
6: Francais
7: Italiano
8: Korean

Date display format (Smart 
Manager only)

Display format of year / 
month / day

1: yyyy/mm/dd
2: dd/mm/yyyy
3: mm/dd/yyyy
4: yyyy.mm.dd
5: dd.mm.yyyy
6: mm.dd.yyyy
7: yyyy-mm-dd
8: dd-mm-yyyy
9: mm-dd-yyyy

Starting day of the week (Smart 
Manager only) Starting day of the week

1: Sunday
2: Monday

Temperature display: Interval Unit of temperature interval
0: Unit 1°C.
1: Unit 0.5°C.

Temperature display: °C./°F. Celsius / Fahrenheit
0: °C.
1: °F.

Support Information Support information Characters (Up to 38 bytes per line)
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The following table shows the operations of Lock Linkage Mode:

Server Setting Tab
The following table shows the settings configured on the Server Setting tab:

Compliant Manager, Smart Manager

Interface Address Tab
The following table shows the settings configured on the Interface Address tab:

Compliant Manager, Smart Manager

Setting Lock (OFF > ON) Unlock (ON > OFF)

0: Setting No.0 Stop No effect

1: Setting No.1 Stop Release "Run – Stop" switch prohibition

2: Setting No.2 Stop + Prohibit "Run – 
Stop" switch Release "Run – Stop" switch prohibition

3: Setting No.3 Stop Run

Item Content Data type / range

IP Address IP address of the Web server Numeric value

Subnet Mask Subnet mask of the Web server Numeric value

Default Gateway Gateway of the Web server Numeric value

Digital I/O Relay Interface Q'ty Number of digital I/O interfaces 0 - 4

Energy Monitoring Relay Interface Q'ty Number of energy monitoring interfaces 0 - 4

Item Content Data type / range

Energy Monitoring Relay Interface

Address Data Interface number 1 - 4

Digital I/O Relay Interface

Address Data Interface number 1 - 4
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Interface Setting Tab
The following table shows the settings configured on the Interface Setting tab:

Compliant Manager, Smart Manager

Outdoor Tab
The following table shows the settings configured on the Outdoor tab:

Compliant Manager, Smart Manager

CAUTION

Fire alarm function that described in this manual can not be used with UL-approved system (Model: BMS-
SM1281HTLUL).

Item Content Data type / range

Energy Monitoring Relay Interface

I/O Function Select the I/O function
0 : No setting
4 : Power Meter Signal Input

Pulse constants (kWh / pulse) Set the pulse constants 0.1 – 99.9

Digital I/O Relay Interface

I/O Function (Smart Manager only) Select the I/O function

0 : No setting
1 : Fire Alarm Input
2 : Door Lock Input
5 : Demand

Signal logic Select the signal logic
0 : negative logic
1 : positive logic

Item Content Data type / range

LINE No Select the line No. address 1 - 2

Line address Refrigerant line number 1 - 32

Outdoor unit combination model name Select the outdoor unit models

Outdoor unit model name Select the outdoor unit models

Outdoor name Enter the line name Characters

Outdoor unit address Unit number

Power meter input name Select the input name for energy monitoring
No setting
WHE-1-1_1 - WHE-1-4_8
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Zone Tab
The following table shows the settings configured on the Zone tab:

Compliant Manager, Smart Manager

Indoor Tab
The following table shows the settings configured on the Indoor tab:

Compliant Manager, Smart Manager

CAUTION

Fire alarm function that described in this manual can not be used with UL-approved system (Model: BMS-
SM1281HTLUL).

Item Content Data type / range

Name Zone name
Characters (Up to 20 bytes for Floor / Area, Up to 40 
bytes for Tenant, Up to 100 bytes for Monthly report 
tenant Forbidden: > < " & \n ; ,)

Tally Classifications Select the tally classification

0: N/A
1: Common use area
2: Tenant
Monthly report tenant only

Monthly report tenant name Select the monthly report tenant 
name

None
Monthly report tenant name list
Tenant only

Item Content Data type / range

LINE No Select the line No. address 1 - 2

Line Address Refrigerant line number 1 - 32

Indoor unit address Unit number 1 - 64

Parent Indoor Unit No. Number to distinguish parent and 
child

0: Parent
1 – 128: Child

Indoor unit model name Select from indoor unit models

R.C.group / indoor name Enter the line name Characters (Up to 20 bytes, Forbidden: > < " & \n ; ,)

Floor name Select the floor
No setting
Floor name list

Tenant name Select the tenant
No setting
Tenant name list

Area name Select the area
No setting
Area name list

Door-lock input name Select the input name for lock 
linkage

No setting
DIO-1-1_IN-1 - DIO-1-4_IN-8

Fire alarm input name Select the input name for fire 
alarm linkage

No setting
DIO-1-1_IN-1 - DIO-1-4_IN-8

Power meter input name Select the input name for energy 
monitoring

No setting
WHE-1-1_1 - WHE-1-4_8

General purpose interface Energy 
Coefficient (kWh)

General purpose Interface energy 
coefficient Can be entered

Air Conditioner No. Air-conditioner number 1 - 128
– 69 –
69-EN



EN

Setting File Creation Software for North America Operating Instructions
Demand Tab
The following table shows the settings configured on the Demand tab:

Smart Manager

Set tree count and name Screen
The following table shows the settings configured on the Set tree count and name screen:

Smart Manager

Item Content Data type / range

Indoor

Control Mode Indoor demand alarm setting

0: Stop
10: Thermo Off (No Delay Cancel)
11: Thermo Off (10-sec Delay)
12: Thermo Off (20-sec Delay)
13: Thermo Off (30-sec Delay)
14: Thermo Off (60-sec Delay)
20: FAN
30: Prohibition of ON / OFF

Item Content Data type / range

Zone 1 name Zone name - Floor Characters (Up to 30 bytes, Forbidden: > < " & \n ; ,)

Zone 2 name Zone name - Tenant Characters (Up to 30 bytes, Forbidden: > < " & \n ; ,)

Zone 3 name Zone name - Area Characters (Up to 30 bytes, Forbidden: > < " & \n ; ,)
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7 Touch Screen Controller

Using the Setting File Creation Software for North America

Starting / Exiting the Setting File Creation Software for North America

Starting the Setting File Creation Software for North America
Use the desktop icon or Windows menu to start the Setting File Creation Software for North America.

1. Start the Setting File Creation Software for North America.

• Desktop icon 
Double-click the desktop icon.

Fig.115 Setting File Creation Software for North America desktop icon

• Windows menu 
Select [Start] > [All Programs] > [Toshiba] > [Setting File Creation Software for North America].

2. The startup screen appears.
The startup screen appears.

Fig.116 Startup screen

3. Data Download Software Startup Complete
The startup screen (Fig.116) disappears, and the Main Menu screen (Fig.2) appears. The Setting File Creation 
Software for North America startup is now complete, and the software can be operated.
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Exiting the Setting File Creation Software for North America
Click the [Close] button, the Exit button, or select the [File] menu then [Exit].

Fig.117 [Main Menu] screen (Close button)

Fig.118 [Main Menu] screen (Exit button)

Fig.119 [Main Menu] screen (Exit menu)

The exit confirmation dialog box appears.
Click [Yes] to exit, or [No] to cancel exiting.

Fig.120 Exit confirmation dialog box

Click button

Click button

Click button
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Creating New Data
Click the [New] button, or select the [File] menu then [New]. The Select System screen (Fig.3) appears.

Fig.121 [Main Menu] screen (New button 1)

Fig.122 [Main Menu] screen (New button 2)

Fig.123 [Main Menu] screen (New menu)

Click button

Click button
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Selecting a File to Edit Data
Click the [Select File] button, the [Open] button, or select the [File] menu then [Open]. The Open screen appears.

Fig.124 [Main Menu] screen (Select File button)

Fig.125 [Main Menu] screen (Open button)

Fig.126 [Main Menu] screen (Open menu)

Click button

Click button
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When the Open screen has opened, select a file to edit. The system screen (Fig.4) appears.

Fig.127 [Open] screen
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Using a History File to Edit Data
Double-click a line in the History List, or select a file from Recently Used File. The system screen (Fig.4) appears.

Fig.128 [Main Menu] screen (History List)

Double-click
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Up to 9 files are stored in Recently Used File.

Fig.129 [Main Menu] screen (Recently Used File)

If the selected file does not exist, a warning appears.

Fig.130 Warning message box
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Setting Up the System
Select the [System] tab and configure the settings.

Fig.131 [System] tab

The following table shows how to enter / select data:

Table.1 How to enter / select data

Item Data type Selection Note

Building name Entered by user

Touch Screen Controller No. Selected by user Select from list

Controller Built-in IO Selected by user Select from list

Indoor unit total Q'ty Entered by user Numeric value only Up to 512

Daily report closing time Entered by user Time only

Monthly report closing date Entered by user Numeric value only

Lock Linkage Mode Selected by user Select from list

Scheduled operation central setting Selected by user Select from list

Energy Monitoring Selected by user Select from list

Stand-by power counting Selected by user Select from list

Whole building display mode Selected by user Select from list

Number of block display buttons Entered by user Numeric value only

Number of tenant display buttons Entered by user Numeric value only

Number of area display buttons Entered by user Numeric value only

Number of R.C.group / indoor display buttons Entered by user Numeric value only

Schedule setting unit Selected by user Select from list

Filter sign display mode Selected by user Select from list

Back light save count (minutes) Entered by user Numeric value only

Words in error code definition file Selected by user Select from list
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Setting Up the Server
Select the [Server Setting] tab under the [Server / Interface] tab, and set the numbers of the interfaces.

Fig.132 [Server Setting] tab

The following table shows how to enter / select data:

Table.2 How to enter / select data

Item Data type Selection Note

IP Address Entered by user Numeric value only Set by Touch Screen 
Controller No.

Subnet Mask Entered by user Numeric value only

Default Gateway Entered by user Numeric value only

TCS-net Relay Interface Q'ty Entered by user Numeric value only 1 - 12

Digital I/O Relay Interface Q'ty Entered by user Numeric value only 0 - 8

Energy Monitoring Relay Interface Q'ty Entered by user Numeric value only 0 - 8
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Setting Up the Interface Address
Select the [Interface Address] tab under the [Server / Interface] tab, and configure the settings.

Fig.133 [Interface Address] tab

The following table shows how to enter / select data:

Table.3 How to enter / select data

Item Data type Selection Note

TCS-Net Relay Interface Address Data Entered by user Numeric value only

Energy Monitoring Relay Interface Address Data Entered by user Numeric value only

Digital I/O Relay Interface Address Data Entered by user Numeric value only
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Setting Up the Interface Function
Select the [Interface Setting] tab under the [Server / Interface] tab, and configure the settings.

Fig.134 [Interface Setting] tab

The following table shows how to enter / select data:

Table.4 How to enter / select data

Item Data type Selection Note

I/O Function Selected by user Select from list

Signal logic Selected by user Select from list Digital I/O Interface 
only

Pulse constants Entered by user Numeric value only
0.1 to 99.9, Energy 
Monitoring Relay 
interface only
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Adding an Outdoor Unit
Click the [New] button, or select the [Operation] menu > [Outdoor Unit] > [New]. A line will be added to the outdoor 
unit list.

Fig.135 [Outdoor] tab (New button)

Fig.136 [Outdoor] tab (New menu)

The following table shows how to enter / select data:

Table.5 How to enter / select data

Item Data type Selection Note

IF No Selected by user Select from list

Line address Entered by user

Outdoor unit combination model name Selected by user Select from the Select 
outdoor unit model 
screenOutdoor unit model name Cannot be edited

Outdoor unit address Cannot be edited

Power monitoring Selected by user Select from list

Click button
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Selecting an Outdoor Unit
Clicking a cell of an outdoor unit combination model name on the [Outdoor] tab (Fig.6) displays the Select outdoor 
unit model screen. On the screen, double-click a cell of an outdoor unit model, or select a model then click the OK 
button. "Outdoor unit combination model name," "Outdoor unit model name," and "Outdoor unit address" will 
automatically become available on the [Outdoor] tab (Fig.6). To cancel changing the outdoor unit setting, click the 
Cancel button to return to the [Outdoor] tab.

Fig.137 [Select outdoor unit model] screen
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Copying the Data of an Outdoor Unit
Select a line of an outdoor unit on the [Outdoor] tab (Fig.6), and click the [Copy] button, or select the [Operation] 
menu > [Outdoor Unit] > [Copy]. The copied outdoor unit will be added to the outdoor unit list. The numbers of the 
copied “Line address" will automatically be increased in one.

Fig.138 [Outdoor] tab (Copy button)

Fig.139 [Outdoor] tab (Copy menu)

Click button
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Copying the Data of Multiple Outdoor Units
Select a line of outdoor unit on the [Outdoor] tab (Fig.6), and click the [Multicopy] button, or select the [Operation] 
menu > [Outdoor Unit] > [Multicopy]. The Copy line count screen appears.

Fig.140 [Outdoor] tab (Multicopy button)

Fig.141 [Outdoor] tab (Multicopy menu)

Enter the copy count, then click the OK button. The copied outdoor units will be added to the outdoor unit list. The 
numbers of the copied “Line address" will automatically be increased in one.

Fig.142 [Copy line count] screen

Click button
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Deleting the Data of Outdoor Units
Select one or more lines of outdoor units on the [Outdoor] tab (Fig.6), and click the [Delete] button, or select the 
[Operation] menu > [Outdoor Unit] > [Delete].

Fig.143 [Outdoor] tab (Delete button)

Fig.144 [Outdoor] tab (Delete menu)

The deletion confirmation dialog box appears.
Click the OK button to delete. The outdoor units will be deleted from the outdoor unit list. To cancel deletion, click 
the Cancel button.

Fig.145 Deletion confirmation dialog box

Click button
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Inserting an Outdoor Unit
Select a line of an outdoor unit on the [Outdoor] tab (Fig.6), and click the [Insert] button, or select the [Operation] 
menu > [Outdoor Unit] > [Insert]. A line will be inserted at the selected location in the outdoor unit list.

Fig.146 [Outdoor] tab (Insert button)

Fig.147 [Outdoor] tab (Insert menu)

Click button
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Editing a Zone Name
On the [Zone] tab, select a section (Block, Monthly report tenant, Tenant, Area) from the combo box in the upper 
left corner of the window. Enter a name in the displayed zone list.

Fig.148 [Zone] tab (Floor)

Fig.149 [Zone] tab (Monthly report tenant)

Click
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Fig.150 [Zone] tab (Tenant)

Fig.151 [Zone] tab (Area)
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Adding a Zone
Click the [New] button, or select the [Operation] menu > [Tree] > [New]. A line will be added to the zone list.

Fig.152 [Zone] tab (New button)

Fig.153 [Zone] tab (New button)

The following table shows how to enter / select data:

Table.6 How to enter / select data

Item Data type Selection Note

Name Entered by user

Tally Classifications Selected by user Select from list Monthly report tenant 
only

Monthly report tenant name Selected by user Select from list Tenant only

Click button
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Copying the Data of a Zone
Select a line of a zone on the [Zone] tab, and click the [Copy] button, or select the [Operation] menu > [Tree] > 
[Copy]. The copied zone will be added to the zone list. The number of the copied “Name" will automatically be 
increased in one.

Fig.154 [Zone] tab (Copy button)

Fig.155 [Zone] tab (Copy menu)

Click button
– 91 –
91-EN



EN

Setting File Creation Software for North America Operating Instructions
Copying the Data of Multiple Zones
Select a line of zone on the [Zone] tab, and click the [Multicopy] button, or select the [Operation] menu > [Tree] > 
[Multicopy]. The Copy line count screen appears.

Fig.156 [Zone] tab (Multicopy button)

Fig.157 [Zone] tab (Multicopy menu)

Enter the copy count, then click the OK button. The copied zones will be added to the zone list. The number of the 
copied “Name" will automatically be increased in one.

Fig.158 [Copy line count] screen

Click button
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Deleting the Data of Zones
Select one or more lines of zones on the [Zone] tab (Fig.7), and click the [Delete] button, or select the [Operation] 
menu > [Tree] > [Delete].

Fig.159 [Zone] tab (Delete button)

Fig.160 [Zone] tab (Delete menu)

The deletion confirmation dialog box appears.
Click the OK button to delete. The zones will be deleted from the zone list. To cancel deletion, click the Cancel 
button.

Fig.161 Deletion confirmation dialog box

Note that the following data will also be deleted if a zone is deleted:
• The Zone setting of an indoor unit set to the deleted zone

Click button
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Inserting a Zone
Select a line of a zone on the [Zone] tab (Fig.7), and click the [Insert] button, or select the [Operation] menu > [Tree] 
> [Insert]. A line will be inserted at the selected location in the zone list.

Fig.162 [Zone] tab (Insert button)

Fig.163 [Zone] tab (Insert menu)

Click button
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Renumbering the Zones
Click the [Renumber] button, or select the [Operation] menu > [Tree] > [Renumber]. The numbers in the “No” 
column will be reassigned.

Fig.164 [Zone] tab (Renumber button)

Fig.165 [Zone] tab (Renumber menu)

Click button
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Changing the Order of the Zones
Select a line of a zone on the [Zone] tab (Fig.7), and click the [Up] / [Down] button, or select the [Operation] menu 
> [Tree] > [Up] / [Down]. The selected line moves up or down.

Fig.166 [Zone] tab (Up button)

Fig.167 [Zone] tab (Down button)

Fig.168 [Zone] tab (Up menu)

Click button

Click button
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Fig.169 [Zone] tab (Down menu)
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Adding an Indoor Unit
Click the [New] button, or select the [Operation] menu > [Indoor Unit] > [New]. A line will be added to the indoor 
unit list.

Fig.170 [Indoor] tab (New button)

Fig.171 [Indoor] tab (New menu)

Click button
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The following table shows how to enter / select data:

Table.7 How to enter / select data

CAUTION

Fire alarm function that described in this manual can not be used with UL-approved system (Model: BMS-
SM1281HTLUL).

Selecting an indoor unit
Clicking a cell of an indoor unit model name on the [Indoor] tab (Fig.8) displays the Select indoor unit model screen. 
On the screen, double-click a cell of an indoor unit model, or select a model then click the OK button. "Indoor unit 
model name" will automatically become available on the [Indoor] tab (Fig.8). To cancel changing the indoor unit 
setting, click the Cancel button to return to the [Indoor] tab.

Fig.172 [Select indoor unit model] screen

Item Data type Selection Note
IF No Selected by user Select from list
Line Address Entered by user
Indoor unit address Entered by user
Parent Indoor Unit No. Entered by user

Indoor unit model name Selected by user
Select from the Select 
indoor unit model 
screen

R.C.group / indoor name Entered by user
Block name Selected by user Select from list
Tenant name Selected by user Select from list
Area name Selected by user Select from list
Door-lock input name Selected by user Select from list
Fire alarm input name Selected by user Select from list
Power meter input name Selected by user Select from list
General purpose interface Energy cofficient 
(kWh) Entered by user

Air Conditioner No. Entered by user
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Copying the Data of an Indoor Unit
Select a line of an indoor unit on the [Indoor] tab (Fig.8), and click the [Copy] button, or select the [Operation] menu 
> [Indoor Unit] > [Copy]. The copied indoor unit will be added to the indoor unit list. The numbers of the copied 
“Indoor unit address" and “R.C.group / indoor name” will automatically be increased in one.

Fig.173 [Indoor] tab (Copy button)

Fig.174 [Indoor] tab (Copy menu)

Click button
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Copying the Data of Multiple Indoor Units
Select a line of indoor unit on the [Indoor] tab (Fig.8), and click the [Multicopy] button, or select the [Operation] menu 
> [Indoor Unit] > [Multicopy]. The Copy line count screen appears.

Fig.175 [Indoor] tab (Multicopy button)

Fig.176 [Indoor] tab (Multicopy menu)

Enter the copy count, then click the OK button. The copied indoor units will be added to the indoor unit list. The 
numbers of the copied “Indoor unit address" and “R.C.group / indoor name” will automatically be increased in one.

Fig.177 [Copy line count] screen

Click button
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Deleting the Indoor Units
Select one or more lines of indoor units on the [Indoor] tab (Fig.8), and click the [Delete] button, or select the 
[Operation] menu > [Indoor Unit] > [Delete].

Fig.178 [Indoor] tab (Delete button)

Fig.179 [Indoor] tab (Delete menu)

The deletion confirmation dialog box appears.
Click the OK button to delete. The indoor units will be deleted from the indoor unit list. To cancel deletion, click the 
Cancel button.

Fig.180 Deletion confirmation dialog box

Click button
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Inserting an Indoor Unit
Select a line of an indoor unit on the [Indoor] tab (Fig.8), and click the [Insert] button, or select the [Operation] menu 
> [Indoor Unit] > [Insert]. A line will be inserted at the selected location in the indoor unit list.

Fig.181 [Indoor] tab (Insert button)

Fig.182 [Indoor] tab (Insert menu)

Click button
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Changing the Order of the Indoor Units
Select a line of an indoor unit on the [Indoor] tab (Fig.8), and click the [Up] / [Down] button, or select the [Operation] 
menu > [Indoor Unit] > [Up] / [Down]. The selected line moves up or down.

Fig.183 [Indoor Unit] tab (Up button)

Fig.184 [Indoor Unit] tab (Down button)

Fig.185 [Indoor Unit] tab (Up menu)

Click button

Click button
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Fig.186 [Indoor Unit] tab (Down menu)
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Deleting All Air Conditioner No. of the Indoor Units
Click the [Clear] button, or select the [Operation] menu > [Indoor Unit] > [Clear]. All the Air Conditioner No. will be 
deleted.

Fig.187 [Indoor Unit] tab (Clear button)

Fig.188 [Indoor Unit] tab (Clear menu)

Click button
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Saving Created Data to a File
Click the [Save] button, or select the [File] menu then [Save Setting File] or [Save Setting File As].

Fig.189 [Save] button

Fig.190 [Save Setting File] menu

Fig.191 [Save Setting File As] menu

Click button
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When a new file is created or the menu [Save Setting File As] is selected, the [Save As] screen appears. Select a 
destination folder and enter a file name.

Fig.192 [Save As] screen

When the data is to be saved to an existing file, the overwrite confirmation dialog box appears. Click the OK button 
to overwrite the file. To cancel saving and return to the data input screen, click the Cancel button.

Fig.193 Overwrite confirmation dialog box
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Outputting a DEF File
Click the [Output File] button, or select the [File] menu then [Output DEF File].

Fig.194 [Output File] button

Fig.195 [Output DEF File] menu

The overwrite confirmation dialog box appears. Click the OK button to Overwrite the file. To cancel saving and 
return to the data input screen, click the cancel button.

Fig.196 Overwrite confirmation dialog box

Click button
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The Browse For Folder screen appears. Select a destination folder to save the DEF file to.

Fig.197 [Browse For Folder] screen

The entered data will be checked. If the data contains an error, the item and error message box appear. Modify the 
section containing the error.

Fig.198 Example of error message box

When the DEF file output is complete, a message appears. Select the "Start up the upload screen." checkbox and 
click the OK button. The upload screen appears.

Fig.199 DEF file output complete dialog box
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Deleting a File History
You can delete a selected history item or all the history items.
• Delete Selected History
• Delete All

Fig.200 [Main Menu] screen (Delete History)

The deletion confirmation dialog box appears.
Click the OK button to delete. The history item will be deleted from the History List. To cancel deletion, click the 
Cancel button.

Fig.201 Deletion confirmation dialog box

This history item is deleted 
if [Delete Selected History] 
is selected
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Uploading a Setting File (DEF File)

Uploading a Setting File (DEF File)
Click the [Upload] button or select the [File] menu then [Upload] on the [Main Menu] screen (Fig.2) or [Data Input 
Main] screen (Fig.4). The Upload Settings screen (Fig.14) appears.

Fig.202 [Main Menu] screen (Upload button)

Fig.203 [Main Menu] screen (Upload menu)

Fig.204 [Data Input Main] screen (Upload button)

Fig.205 [Data Input Main] screen (Upload menu)

Click button

Click button
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Specifying Setting File Data
Specify the setting file data to upload.

Fig.206 [Upload Settings] screen (Specify file directly)

Select a file on the Open screen.

Fig.207 [Open] screen

Click button
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Specifying a Setting File Folder
Select a folder.
When setting file data is specified, the folder is automatically selected depending on the setting.

Fig.208 [Upload Settings] screen (Specify folder directly)

Select a folder containing the setting file on the Browse For Folder screen.

Fig.209 [Browse For Folder] screen

Click button
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Specifying a Target System
Select a destination system to upload the file to.
When setting file data is specified, the system is automatically selected depending on the settings.

Fig.210 [Upload Settings] screen (Target System)

Specifying an IP Address
Specify the IP address of the destination system.
When setting file data is specified, the address automatically appears.

Fig.211 [Upload Settings] screen (IP Address)
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The following table shows the items in the File List:

Starting the Upload
After the preparation (Specifying Setting File Data (P62) to Specifying an IP Address (P64)) has been completed, 
click the Upload button. The upload starts.

Fig.212 [Upload Settings] screen (Upload button)

The progress bar is displayed during the upload.

Fig.213 Progress bar

CAUTION

If Compliant Manager, Smart Manager or Touch Screen Controller is shut down during upload, stored data may be 
damaged and the controller may not operate.
Do not shut down the controller during upload.

Item Content

File Name Name of the file to upload

Size Size of the file to upload

Last Updated Last updated time of a file to upload

File
Shows whether a setting file exists in the specified folder
Yes: Exists
No: Does not exist

Click button
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System Settings

System Tab
The following table shows the settings configured on the System tab:

Item Content Data type / range

Building name Building name Characters (Up to 100 bytes, Forbidden: ";" ",", control 
character code)

Touch Screen Controller No. Touch Screen Controller 
No.

1: Touch Screen Controller No.1
2: Touch Screen Controller No.2
3: Touch Screen Controller No.3
4: Touch Screen Controller No.4
5: Touch Screen Controller No.5

Controller Built-in IO Whether the controller 
built-in IO is used

0: N/A
1: Valid

Indoor unit total Q'ty Number of indoor units 1 - 512

Daily report closing time Time when the daily report 
is output 0:00 – 23:59

Monthly report closing time Date when the monthly 
report is output 1 - 31

Lock Linkage Mode Lock linkage mode pattern

0: Setting No.0
1: Setting No.1
2: Setting No.2
3: Setting No.3

Scheduled operation central 
setting

Scheduled operation 
central setting

0: No scheduled operation central setting
1: Setting No.1
2: Setting No.2
3: Setting No.3

Energy Monitoring

Whether the energy 
monitoring is used and the 
distribution mode is 
selected

0: Void
1: Valid(Distribution by capacity demand)

Stand-by power counting
Select the distribution 
mode of outdoor heater 
capacity

1: Proportional sharing on indoor unit horse power codes.
2: Equal sharing on indoor units Q'ty
3: Distribution of power consumption except compressor 

warmer to tenants.

Whole building display mode Display mode setting

0: Block
1: Tenant
2: Area
3: R.C.group / indoor

Number of block display buttons Number of buttons 1 - 10

Number of tenant display buttons Number of buttons 1 - 10

Number of area display buttons Number of buttons 1 - 10

Number of R.C.group / indoor 
display buttons Number of buttons 1 - 10

Schedule setting unit Schedule unit
0: Area unit
1: R.C.group / indoor

Filter sign display mode Filter sign display mode
0: not display
1: display

Back light save count (minutes) Backlight off time 0 - 99

Words in error code definition file Language of error codes

1: English
2: Chinese (Simplified)
4: Deutsch
5: Espanol
6: Francais
7: Italiano
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The following table shows the operations of Lock Linkage Mode:

The following table shows the operations of Schedule setting unit:

Server Setting Tab
The following table shows the settings configured on the Server Setting tab:

Interface Address Tab
The following table shows the settings configured on the Interface Address tab:

Setting Lock (OFF > ON) Unlock (ON > OFF)

0: Setting No.0 Stop No effect

1: Setting No.1 Stop Release "Run – Stop" switch prohibition

2: Setting No.2 Stop + Prohibit "Run – 
Stop" switch Release "Run – Stop" switch prohibition

3: Setting No.3 Stop Run

Setting Stop (10 minutes or later) Stop (within 10 minutes) Run

0: No scheduled operation 
central setting Stop Stop Run

1: Setting No.1 Stop + Release "Run – 
Stop" switch prohibition

Stop + Release "Run – 
Stop" switch prohibition

Run + Release "Run – Stop" 
switch prohibition

2: Setting No.2 Stop + Release "Run – 
Stop" switch prohibition

Stop + Prohibit "Run – Stop" 
switch

Release "Run – Stop" 
switch prohibition

3: Setting No.3 Stop + Release "Run – 
Stop" switch prohibition

Stop + Prohibit "Run – Stop" 
switch

Run + Release "Run – Stop" 
switch prohibition

Item Content Data type / range

IP Address IP address of the Web server Numeric value

Subnet Mask Subnet mask of the Web server Numeric value

Default Gateway Gateway of the Web server Numeric value

TCS-net Relay Interface Q'ty Number of TCS-net relay interfaces 1 - 12

Digital I/O Relay Interface Q'ty Number of digital I/O interfaces 0 - 8

Energy Monitoring Relay Interface Q'ty Number of energy monitoring interfaces 0 - 8

Item Content Data type / range

TCS-net relay Interface

Address Data Interface number 1-12

Energy Monitoring Relay Interface

Address Data Interface number 1 - 8

Digital I/O Relay Interface

Address Data Interface number 1 - 8
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Interface Setting Tab
The following table shows the settings configured on the Interface Setting tab:

Outdoor Tab
The following table shows the settings configured on the Outdoor tab:

Zone Tab
The following table shows the settings configured on the Zone tab:

CAUTION

Fire alarm function that described in this manual can not be used with UL-approved system (Model: BMS-
SM1281HTLUL).

Item Content Data type / range

Energy Monitoring Relay Interface

I/O Function Select the I/O function
0 : No setting
4 : Power Meter Signal Input

Pulse constants(kWh / pulse) Set the pulse constants 0.1 – 99.9

Digital I/O Relay Interface

I/O Function Select the I/O function
0 : No setting
1 : Fire Alarm Input
2 : Door Lock Input

Signal logic Select the signal logic
0 : negative logic
1 : positive logic

Controller Built-in IO

I/O Function Select the I/O function
0 : No setting
1 : Fire Alarm Input
2 : Door Lock Input

Signal logic Select the signal logic
0 : negative logic
1 : positive logic

Item Content Data type / range

IF No Select the TCS-net Relay Interface address 1 - 12

Line address Refrigerant line number 1 - 32

Outdoor unit combination model name Select the outdoor unit models

Outdoor unit model name Select the outdoor unit models

Outdoor unit address Unit number 1 only

Power meter input name Select the input name for energy monitoring
No setting
WHE-1-1_1 - WHE-1-8_8

Item Content Data type / range

Name Zone name Characters (Up to 100 bytes, Forbidden: ";" ",", 
control character code)

Tally Classifications Select the tally classification
0: N/A
1: Common use area
2: Tenant

Monthly report tenant name Select the monthly report tenant 
name

No setting
Monthly report tenant name list
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Indoor Tab
The following table shows the settings configured on the Indoor tab:

CAUTION

Fire alarm function that described in this manual can not be used with UL-approved system (Model: BMS-
SM1281HTLUL).

Item Content Data type / range

IF No Select the TCS-net relay interface 
address 1 - 12

Line Address Refrigerant line number 1 - 32

Indoor unit address Unit number 1 - 64

Parent Indoor Unit No. Number to distinguish parent and 
child

0: Parent
1 – 512: Child

Indoor unit model name Select from indoor unit models

R.C.group / indoor name Enter the line name
Characters (Up to 100 bytes, Forbidden: ";" ":", 
single-byte space, double-byte space, control 
character code)

Block name Select the block
No setting
Block name list

Tenant name Select the tenant
No setting
Tenant name list

Area name Select the area
No setting
Area name list

Door-lock input name Select the input name for lock 
linkage

No setting
DIO-1-1_IN-1 - DIO-1-8_IN-8TP_IN-1 - TP_IN-3

Fire alarm input name Select the input name for fire 
alarm linkage

No setting
DIO-1-1_IN-1 - DIO-1-8_IN-8TP_IN-1 - TP_IN-3

Power meter input name Select the input name for energy 
monitoring

No setting
WHE-1-1_1 - WHE-1-8_8

General purpose interface Energy 
Coefficient (kWh)

General purpose Interface energy 
Coefficient Can be entered

Air Conditioner No. Air-conditioner number 1 - 512
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8 Initialization Tool

 Initialization Tool
The Initialization Tool resets the air-conditioner setting file data stored on the Touch Screen Controller, Compliant 
Manager, and Smart Manager, such as the schedule data, alarm history data, and daily / monthly report data, to 
the factory settings.
The tool contains the Restore function, which restores using data backed up with Data Download Software or 
backed up during initialization.

CAUTION

Perform "Initialize System" before restoring. Otherwise, the Monthly Report Creation Software may not work correctly.

Starting / Exiting the Initialization Tool

Starting the Initialization Tool
Use the menu of the Setting File Creation Software for North America or Windows menu to start the Initialization 
Tool.

Menu of the Setting File Creation Software for North America

Fig.214 [Main Menu] screen (Initialization Tool)

Windows menu
Select [Start] > [All Programs] > [Toshiba] > [Setting File Creation Software for North America] > [Initialization Tool].
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Exiting the Initialization Tool
Click the [Close] button, the Exit button, or select the [File] menu then [Exit].

Fig.215 [Main Menu] screen (Close button / Exit button)

Fig.216 [Main Menu] screen (Exit menu)

The exit confirmation dialog box appears.
Click [Yes] to exit, or [No] to cancel exiting.

Fig.217 Exit confirmation dialog box
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 Initializing Data in a Target System
Stored daily / monthly report files are deleted from the target system if a setting file is initialized or specific data 
(Report data files) is deleted.
Before performing this function, save registered power distribution data with Data Download Software.

Initializing a Setting File
When a setting file is initialized, the schedule data, alarm history, and daily / monthly report files will be deleted in 
addition to the setting file.

Follow the procedure below:

1 Specify an IP address.

2 Select the target system.

3 Select [Initialize Setting Files].

4 Specify a backup folder. (Fig.219)
A backup folder can be specified before initializing a setting file. If you do not specify a backup folder, the data 
will be backed up to "C:\Documents and Settings\All Users\Application Data\Toshiba Carrier 
Corporation\Initialization Tool\backup" in Windows XP, or "C:\Program Data\Toshiba Carrier 
Corporation\Initialization Tool\backup" in Windows Vista/7. This folder is a hidden folder. To show the folder, 
you need to change the "Folder Options" settings.

5 Use the PING command to check the connection to the target system.

Fig.218 [Initialization Tool] screen
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Fig.219 [Browse For Folder] screen

6 Click the [Execute] button, or select the [Operation] menu then [Execute].

Fig.220 [Initialization] screen (Execute button / Execute menu)

7 Read the displayed warning message, and select the [Understand these warning messages and 
then perform the processing] checkbox.

Fig.221 [Warning] screen

8 Click the [OK] button. 
The initialization starts, and the progress bar appears.

Fig.222 Progress bar
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9 If the initialization is completed successfully, the completion dialog box appears.

10 Restart the target system. 
Press the reset button, or turn off the power and turn it back on again. When the power is turned 
off, wait until over a minute passes before turning it back on.

Fig.223 Completion dialog box

Deleting Specific Data
Follow the procedure below:

1 Specify an IP address.

2 Select the target system.

3 Select [Delete specific Data].

4 Select data to delete. 
[Schedule], [Alarm History], and [Report data files] can be selected. All the schedules of 
execution, master, and charges will be deleted.

5 Specify a backup folder. (Fig.225)
A backup folder can be specified before  initializing a setting file. If you do not specify a backup folder, the data 
will be backed up to "C:\Documents and Settings\All Users\Application Data\Toshiba Carrier 
Corporation\Initialization Tool\backup" in Windows XP, or "C:\Program Data\Toshiba Carrier 
Corporation\Initialization Tool\backup" in Windows Vista/7. This folder is a hidden folder. To show the folder, 
you need to change the "Folder Options" settings.
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6 Use the PING command to check the connection to the target system.

Fig.224 [Initialization Tool] screen

Fig.225 [Browse For Folder] screen

7 Click the [Execute] button, or select the [Operation] menu then [Execute].

Fig.226 [Initialization] screen (Execute button / Execute menu)
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8 Read the displayed warning message, and select the [Understand these warning messages and 
then perform the processing] checkbox.

Fig.227 [Warning] screen

9 Click the [OK] button. 
The initialization starts, and the progress bar appears.

Fig.228 Progress bar

10 If the initialization is completed successfully, the completion dialog box appears.

11 Restart the target system. 
Press the reset button, or turn off the power and turn it back on again. When the power is turned 
off, wait until over a minute passes before turning it back on.

Fig.229 Completion dialog box
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 Initializing a System
You can reset a target system to its default settings. All data in the system will be deleted.

Follow the procedure below:

1 Specify an IP address.

2 Select the target system.

3 Specify a backup folder. (Fig.231)
A backup folder can be specified before  initializing a setting file. If you do not specify a backup folder, the data 
will be backed up to "C:\Documents and Settings\All Users\Application Data\Toshiba Carrier 
Corporation\Initialization Tool\backup" in Windows XP, or "C:\Program Data\Toshiba Carrier 
Corporation\Initialization Tool\backup" in Windows Vista/7. This folder is a hidden folder. To show the folder, 
you need to change the "Folder Options" settings.

4 Use the PING command to check the connection to the target system.

Fig.230 [Initialization Tool] screen

Fig.231 [Browse For Folder] screen
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5 Select the [Tool] menu then [Initialize System].

Fig.232 [Initialization] screen (Initialize System menu)

6 Read the displayed warning message, and select the [Understand these warning messages and 
then perform the processing] checkbox.

Fig.233 [Warning] screen

7 Click the [OK] button. 
The initialization starts, and the progress bar appears.

Fig.234 Progress bar

8 If the initialization is completed successfully, the completion dialog box appears.

9 Restart the target system. 
Press the reset button, or turn off the power and turn it back on again. When the power is turned 
off, wait until over a minute passes before turning it back on.

Fig.235 Completion dialog box
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Restoring Data
You can restore data in a target system from backup using data automatically backed up with Initialization Tool or 
Data Download Software.
Note that all current data in the system will be deleted.
Perform "Initialize System" before restoring. Otherwise, the Monthly Report Creation Software may not work 
correctly.

Follow the procedure below:

1 Specify an IP address.

2 Select the target system.

3 Specify a backup folder. (Fig.237)
A backup folder can be specified before restoring data. If you do not specify a backup folder, the data will be 
backed up to "C:\Documents and Settings\All Users\Application Data\Toshiba Carrier Corporation\Initialization 
Tool\backup" in Windows XP, or "C:\Program Data\Toshiba Carrier Corporation\Initialization Tool\backup" in 
Windows Vista/7. This folder is a hidden folder. To show the folder, you need to change the "Folder Options" 
settings.

4 Use the PING command to check the connection to the target system.

Fig.236 [Initialization Tool] screen

Fig.237 [Browse For Folder] screen
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5 Select the [Tool] menu then [Restore].

Fig.238 [Initialization] screen (Restore menu)

6 The Check Destination Folder screen appears.

7 Click the Browse button, and select the folder containing the restored data on the displayed 
Browse For Folder screen (Fig.240).

8 Click the OK button.

Fig.239 [Check Destination Folder] screen

Fig.240 [Browse For Folder] screen
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9 Read the displayed warning message, and select the [Understand these warning messages and 
then perform the processing] checkbox.

Fig.241 [Warning] screen

10 Click the [OK] button. 
The Restoration starts, and the progress bar appears.

Fig.242 Progress bar

11 If the restoration is completed successfully, the completion dialog box appears.

12 Restart the target system. 
Press the reset button, or turn off the power and turn it back on again. When the power is turned 
off, wait until over a minute passes before turning it back on.

Fig.243 Completion dialog box
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Checking the Version Information
Select the [Help] menu then [About].

Fig.244 [Initialization] screen (About menu)

The version information appears.

Fig.245 [About] screen
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9 License Agreement
Before using "Setting File Creation Software for North America" (hereinafter referred to as "this software," read this 
software's license agreement (hereinafter referred to as "this agreement") carefully.
By using or installing this software in part or as a whole, you agree to be bound by the terms of this agreement.
If you (hereinafter referred to as "the user") do not agree to the terms of this agreement, return it to the place of 
purchase without using or installing this software.

1. Under this agreement, this software means a computer program that is accompanied by this agreement as a 
recording medium or file, plus any and all other data including electronic documentation provided. Data that is 
explicitly not contained in this software is excluded.

2. Toshiba Carrier Corporation retains the ownership and intellectual property rights to this software. The user may 
use this software by agreeing to the terms and conditions of this agreement for purposes designated by Toshiba 
Carrier Corporation or agreed upon by Toshiba Carrier Corporation and the user.

3. Toshiba Carrier Corporation owns the copyright to this software. This software is protected by copyright laws 
and international treaties.

4. The user may duplicate and install this software for purposes described in the documentation for this software. 
The user shall immediately delete a copy of this software when it becomes unnecessary. Excluding the above 
case, the user shall not duplicate this software.

5. The user shall make no attempt to reverse engineer, decompile, disassemble, or alter this software.

6. The user shall not let any other users use this software over a local network or the Internet.

7. The user shall not distribute, give, rent, lease, sell, or sublicense this software or the right to use this software 
to any third party.

8. The user shall respect the intellectual property rights of this software. In addition, the user shall recognize that 
this software is confidential and avoid disclosing this software to any third party.

9. The user agrees to comply with the Foreign Exchange and Foreign Trade Control Law, the Export Trade Control 
Order, the United States Export Administration Act and all applicable international and national laws and 
regulations that apply to this software directly or indirectly.

10.The user is allowed to use this software as is without any explicit or implicit guarantee. No implicit commercial 
guarantees or specific purpose applicability guarantees apply. Toshiba Carrier Corporation has no 
responsibility to guarantee the quality or performance of this software. Toshiba Carrier Corporation has no 
responsibility whatsoever for any damage, loss, cost or expense, incurred by the user, arising from the use of 
this software.

11.If the terms of this agreement are violated or this agreement is cancelled, the user shall uninstall and remove 
this software, and return the recording media and files (including copies) to Toshiba Carrier Corporation.

12.Toshiba Carrier Corporation reserves the right to terminate the use of this software and modify or improve this 
software at any time.

13.This agreement will be governed by and construed in accordance with the laws of Japan. (However, the 
applicable law selection rules are excluded. Hereinafter the same shall apply)
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Appendix A
BACnet

CAUTION

The air conditioner number is used as the identifier (address) for the air conditioner on the system when it is 
connected to the system.
This number is automatically indexed when a file is output, if an indoor unit is added, deleted, or moved on the 
indoor tab, the air conditioner number before the change may be different after the change.
Because of this, if the operation above is done, the air conditioner number is changed and the address may be 
incorrect when reconnecting to the system (The air conditioner may not operate or a different air conditioner may 
operate).
If you change the settings on the indoor tab, it may change the air conditioner number used on the system, 
therefore note that it may be necessary to reset the system when outputting the file and uploading to the BACnet 
local server.

Using the Setting File Creation Software for North America

Starting / Exiting the Setting File Creation Software for North America
Starting the Setting File Creation Software for North America
Use the desktop icon or Windows menu to start the Setting File Creation Software for North America.

1 Start the Setting File Creation Software for North America.
• Desktop icon
Double-click the desktop icon.

Fig.246 Setting File Creation Software for North America desktop icon

• Windows menu
Select [Start] > [All Programs] > [Toshiba] > [Setting File Creation Software for North America].
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2 The startup screen appears.
The startup screen appears.

Fig.247 Startup screen

3 Setting File Creation Software for North America Startup Complete.
The startup screen (Fig.247) disappears, and the Main Menu screen (Fig.2) appears. The Setting File Creation 
Software for North America startup is now complete, and the software can be operated.
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Exiting the Setting File Creation Software for North America
Click the [Close] button, the Exit button, or select the [File] menu then [Exit].

Fig.248 [Main Menu] screen (Close button)

Fig.249 [Main Menu] screen (Exit button)

Fig.250 [Main Menu] screen (Exit menu)

The exit confirmation dialog box appears.
Click [Yes] to exit, or [No] to cancel exiting.

Fig.251 Exit confirmation dialog box

Click button

Click button
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Creating New Data
Click the [New] button, or select the [File] menu then [New]. The Select System screen (Fig.3) appears.

Fig.252 [Main Menu] screen (New button 1)

Fig.253 [Main Menu] screen (New button 2)

Fig.254 [Main Menu] screen (New menu)

When the Open screen has opened, select a file to edit. The system screen (Fig.4) appears.

Fig.255 [Open] screen

Click button

Click button
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Using a History File to Edit Data
Double-click a line in the History List, or select a file from Recently Used File. The system screen (Fig.4) appears.

Fig.256 [Main Menu] screen (History List)

Double-click
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Up to 9 files are stored in Recently Used File.

Fig.257 [Main Menu] screen (Recently Used File)

If the selected file does not exist, a warning appears.

Fig.258 Warning message box
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Setting Up the System
Select the [System] tab and configure the settings.

Fig.259 [System] tab

The following table shows how to enter / select data:

Table.1 How to enter / select data

Item Data type Selection Note

Building name Entered by user

Indoor unit total Q'ty Entered by user Numeric value only Up to 128

Temperature display: Interval Selected by user Select from list

Temperature display: C./F. Selected by user Select from list
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Setting Up the Server
Select "Server Setting" on the "Server / Interface" tab and set the number of interfaces and the IP address of the 
BACnet local server.
On the BACnet, when the server's IP address is uploaded it is automatically edited according to the IP address, 
subnet mask, and default gateway information set in this tab.

Fig.260 [Server Setting] tab

The following table shows how to enter / select data:

Table.2 How to enter / select data

Item Data type Selection Note

IP Address Entered by user Numeric value only

Subnet Mask Entered by user Numeric value only

Default Gateway Entered by user Numeric value only

TCS-net Relay Interface Q'ty Entered by user Numeric value only 1 - 8
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Setting Up the Interface Address
Select the [Interface Address] tab under the [Server / Interface] tab, and configure the settings.

Fig.261 [Interface Address] tab

The following table shows how to enter / select data:

Table.3 How to enter / select data

Item Data type Selection Note

TCS-Net Relay Interface Address Data Entered by user Numeric value only 1 - 8
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Adding an Outdoor Unit
Click the [New] button, or select the [Operation] menu > [Outdoor Unit] > [New]. A line will be added to the outdoor 
unit list.

Fig.262 [Outdoor] tab (New button)

Fig.263 [Outdoor] tab (New menu)

The following table shows how to enter / select data:

Table.4 How to enter / select data

Item Data type Selection Note

IF No Selected by user Select from list

Line address Entered by user Numeric value only

Outdoor unit combination model name Selected by user Select from the Select 
outdoor unit model screen

Outdoor unit model name Cannot be edited Select from the Select 
outdoor unit model screen

Outdoor name Entered by user

Outdoor unit address Cannot be edited

Click button
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Selecting an Outdoor Unit
Clicking a cell of an outdoor unit combination model name on the [Outdoor] tab (Fig.6) displays the Select outdoor 
unit model screen. On the screen, double-click a cell of an outdoor unit model, or select a model then click the OK 
button. “Outdoor unit combination model name”, “Outdoor unit model name,” and “Outdoor unit address” will 
automatically become available on the [Outdoor] tab (Fig.6). To cancel changing the outdoor unit setting, click the 
Cancel button to return to the [Outdoor] tab.

Fig.264 [Select outdoor unit model] screen
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Copying the Data of an Outdoor Unit
Select a line of an outdoor unit on the [Outdoor] tab (Fig.6), and click the [Copy] button, or select the [Operation] 
menu > [Outdoor Unit] > [Copy]. The copied outdoor unit will be added to the outdoor unit list. The numbers of the 
copied “Line address” will automatically be increased in one.

Fig.265 [Outdoor] tab (Copy button)

Fig.266 [Outdoor] tab (Copy menu)

Click button
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Copying the Data of Multiple Outdoor Units
Select a line of outdoor unit on the [Outdoor] tab (Fig.6), and click the [Multicopy] button, or select the [Operation] 
menu > [Outdoor Unit] > [Multicopy]. The Copy line count screen appears.

Fig.267 [Outdoor] tab (Multicopy button)

Fig.268 [Outdoor] tab (Multicopy menu)

Enter the copy count, then click the OK button. The copied outdoor units will be added to the outdoor unit list. The 
numbers of the copied “Line address” will automatically be increased in one.

Fig.269 [Copy line count] screen

Click button
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Deleting the Data of Outdoor Units
Select one or more lines of outdoor units on the [Outdoor] tab (Fig.6), and click the [Delete] button, or select the 
[Operation] menu > [Outdoor Unit] > [Delete].

Fig.270 [Outdoor] tab (Delete button)

Fig.271 [Outdoor] tab (Delete menu)

The deletion confirmation dialog box appears.
Click the OK button to delete. The outdoor units will be deleted from the outdoor unit list. To cancel deletion, click 
the Cancel button.

Fig.272 Deletion confirmation dialog box

Click button
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Inserting an Outdoor Unit
Select a line of an outdoor unit on the [Outdoor] tab (Fig.6), and click the [Insert] button, or select the [Operation] 
menu > [Outdoor Unit] > [Insert]. A line will be inserted at the selected location in the outdoor unit list.

Fig.273 [Outdoor] tab (Insert button)

Fig.274 [Outdoor] tab (Insert menu)

Click button
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Adding an Indoor Unit
Click the [New] button, or select the [Operation] menu > [Indoor Unit] > [New]. A line will be added to the indoor 
unit list.

Fig.275 [Indoor] tab (New button)

Fig.276 [Indoor] tab (New menu)

The following table shows how to enter / select data:

Table.5 How to enter / select data

Item Data type Selection Note

IF No Selected by user Select from list

Line address Entered by user Numeric value only

Indoor unit address Entered by user Numeric value only

Parent Indoor Unit No. Entered by user Numeric value only

Indoor unit model name Selected by user Select from the Select 
indoor unit model screen

R.C.group / indoor name Entered by user

Air Conditioner No. Cannot be edited

Click button
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Selecting an indoor unit
Clicking a cell of an indoor unit model name on the [Indoor] tab (Fig.8) displays the Select indoor unit model screen. 
On the screen, double-click a cell of an indoor unit model, or select a model then click the OK button. “Indoor unit 
model name” will automatically become available on the [Indoor] tab (Fig.8). To cancel changing the indoor unit 
setting, click the Cancel button to return to the [Indoor] tab.

Fig.277 [Select indoor unit model] screen
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Copying the Data of an Indoor Unit
Select a line of an indoor unit on the [Indoor] tab (Fig.8), and click the [Copy] button, or select the [Operation] menu 
> [Indoor Unit] > [Copy]. The copied indoor unit will be added to the indoor unit list. The numbers of the copied 
“Indoor unit address” and “R.C.group / indoor name” will automatically be increased in one.

Fig.278 [Indoor] tab (Copy button)

Fig.279 [Indoor] tab (Copy menu)

Click button
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Copying the Data of Multiple Indoor Units
Select a line of indoor unit on the [Indoor] tab (Fig.8), and click the [Multicopy] button, or select the [Operation] menu 
> [Indoor Unit] > [Multicopy]. The Copy line count screen appears.

Fig.280 [Indoor] tab (Multicopy button)

Fig.281 [Indoor] tab (Multicopy menu)

Enter the copy count, then click the OK button. The copied indoor units will be added to the indoor unit list. The 
numbers of the copied “Indoor unit address” and “R.C.group / indoor name” will automatically be increased in one.

Fig.282 [Copy line count] screen

Click button
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Deleting the Indoor Units
Select one or more lines of indoor units on the [Indoor] tab (Fig.8), and click the [Delete] button, or select the 
[Operation] menu > [Indoor Unit] > [Delete].

Fig.283 [Indoor] tab (Delete button)

Fig.284 [Indoor] tab (Delete menu)

The deletion confirmation dialog box appears.
Click the OK button to delete. The indoor units will be deleted from the indoor unit list. To cancel deletion, click the 
Cancel button.

Fig.285 Deletion confirmation dialog box

Click button
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Inserting an Indoor Unit
Select a line of an indoor unit on the [Indoor] tab (Fig.8), and click the [Insert] button, or select the [Operation] menu 
> [Indoor Unit] > [Insert]. A line will be inserted at the selected location in the indoor unit list.

Fig.286 [Indoor] tab (Insert button)

Fig.287 [Indoor] tab (Insert menu)

Click button
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Changing the Order of the Indoor Units
Select a line of an indoor unit on the [Indoor] tab (Fig.8), and click the [Up] / [Down] button, or select the [Operation] 
menu > [Indoor Unit] > [Up] / [Down]. The selected line moves up or down.

Fig.288 [Indoor Unit] tab (Up button)

Fig.289 [Indoor Unit] tab (Down button)

Fig.290 [Indoor Unit] tab (Up menu)

Fig.291 [Indoor Unit] tab (Down menu)

Click button

Click button
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Saving Created Data to a File
Click the [Save] button, or select the [File] menu then [Save Setting File] or [Save Setting File As].

Fig.292 [Save] button

Fig.293 [Save Setting File] menu

Fig.294 [Save Setting File As] menu

Click button
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When a new file is created or the menu [Save Setting File As] is selected, the [Save As] screen appears. Select a 
destination folder and enter a file name.

Fig.295 [Save As] screen

When the data is to be saved to an existing file, the overwrite confirmation dialog box appears. Click the OK button 
to overwrite the file. To cancel saving and return to the data input screen, click the Cancel button.

Fig.296 Overwrite confirmation dialog box
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Outputting Files
The air conditioner number is used as the identifier (address) for the air conditioner on the system when it is 
connected to the system.
This number is automatically indexed when a file is output, if an indoor unit is added, deleted, or moved on the 
indoor tab, the air conditioner number before the change may be different after the change.
Because of this, if the operation above is done, the air conditioner number is changed and the address may be 
incorrect when reconnecting to the system (The air conditioner may not operate or a different air conditioner may 
operate).
If you change the settings on the indoor tab, it may change the air conditioner number used on the system, 
therefore note that it may be necessary to reset the system when outputting the file and uploading to the BACnet 
local server.

Fig.297 Indoor screen

Click the [Output File] button, or select the [File] menu then [Output DEF File].

Fig.298 [Output File] button

Click button
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Fig.299 [Output DEF File] menu

The overwrite confirmation dialog box appears. Click the OK button to Overwrite the file. To cancel saving and 
return to the data input screen, click the cancel button.

Fig.300 Overwrite confirmation dialog box

The Browse For Folder screen appears. Select a destination folder to save the DEF file to.

Fig.301 [Browse For Folder] screen
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The entered data will be checked. If the data contains an error, the item and error message box appear. Modify the 
section containing the error.

Fig.302 Example of error message box

When the DEF file output is complete, a message appears. Select the “Start up the upload screen.” checkbox and 
click the OK button. The upload screen appears.

Fig.303 DEF file output complete dialog box
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Deleting a File History
You can delete a selected history item or all the history items.
• Delete Selected History
• Delete All

Fig.304 [Main Menu] screen (Delete History)

The deletion confirmation dialog box appears.
Click the OK button to delete. The history item will be deleted from the History List. To cancel deletion, click the 
Cancel button.

Fig.305 Deletion confirmation dialog box
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Uploading a setting file (DEF File)

Uploading a Setting File (DEF File)
Click the [Upload] button or select the [File] menu then [Upload] on the [Main Menu] screen (Fig.2) or [Data Input 
Main] screen (Fig.4). The Upload Settings screen (Fig.14) appears.

Fig.306 [Main Menu] screen (Upload button)

Fig.307 [Main Menu] screen (Upload menu)

Fig.308 [Data Input Main] screen (Upload button)

Fig.309 [Data Input Main] screen (Upload menu)

Click button

Click button
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Specifying Setting File Data
Specify the setting file data to upload.

Fig.310 [Upload Settings] screen (Specify file directly)

Select a file on the Open screen.

Fig.311 [Open] screen

Click button
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Specifying a Setting File Folder
Select a folder.
When setting file data is specified, the folder is automatically selected depending on the setting.

Fig.312 [Upload Settings] screen (Specify folder directly)

Select a folder containing the setting file on the Browse For Folder screen.

Fig.313 [Browse For Folder] screen

Click button
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Specifying a Target System
Select a destination system to upload the file to.
When setting file data is specified, the target system is automatically selected “BACnet (BMS-STBNxxx)”

Fig.314 [Upload Settings] screen (Target System)

Regarding the IP address
If the target system is BACnet, uploading to the server can only be done from Port2 of the BACnet server.The IP 
address of Port2 is fixed as 192.168.0.99, the IP address of Port2 cannot be changed. Also, before uploading it is 
necessary to change the IP address to 192.168.2.98 and the subnet mask to 255.255.255.0 for the PC that is using 
this software. If the change is not done, the upload is not possible.

Fig.315 [Upload Settings] screen (IP Address)
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The following table shows the items in the File List:

Starting the Upload
After the preparation (Specifying Setting File Data) has been completed, click the Upload button. The upload starts.

Fig.316 [Upload Settings] screen (Upload button)

The progress bar is displayed during the upload.

Fig.317 Progress bar

CAUTION

If BACnet server is shut down during upload, stored data may be damaged and the server may not operate.
Do not shut down the server during upload.

Item Content

File Name Name of the file to upload

Size Size of the file to upload

Last Updated Last updated time of a file to upload

File
Shows whether a setting file exists in the specified folder
Yes: Exists
No: Does not exist

Click button
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System settings

System Tab
The following table shows the settings configured on the System tab:

Server Setting Tab
The following table shows the settings configured on the Server Setting tab:

Interface Address Tab
The following table shows the settings configured on the Interface Address tab:

Outdoor Tab
The following table shows the settings configured on the Outdoor tab:

Item Content Data type / range

Building name Building name Characters (Up to 100 bytes,  
Forbidden: “ ' > < : ; , # &)

Indoor unit total Q'ty Number of indoor units 1 - 128

Temperature display: Interval Unit of temperature interval
0: Unit 1 °C.
1: Unit 0.5 °C.

Temperature display: C./F. Celsius / Fahrenheit
0: °C.
1: °F.

Item Content Data type / range

IP Address IP address of the server Numeric value

Subnet Mask Subnet mask of the server Numeric value

Default Gateway Gateway of the server Numeric value

TCS-net Relay Interface Q'ty. Number of TCS-net relay interfaces 1 - 8

Item Content Data type / range

TCS-net relay Interface

Address Data Interface number 1 - 8

Item Content Data type / range

IF No Select the TCS-net Relay Interface 
address 1 - 8

Line address Refrigerant line number 1 - 28

Outdoor unit combination model name Select the outdoor unit models

Outdoor unit model name Select the outdoor unit models

Outdoor name Enter the line name Characters (Up to 100 bytes,  
Forbidden: “ ' > < : ; , # &)

Outdoor unit address Unit number
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Indoor Tab
The following table shows the settings configured on the Indoor tab:

Item Content Data type / range

IF No Select the TCS-net Relay Interface 
address 1 - 8

Line address Refrigerant line number 1 - 31

Indoor unit address Unit number 1 - 64

Parent Indoor Unit No. Number to distinguish parent and 
child

0: Parent
1 - 128: Child

Indoor unit model name Select the indoor unit models

R.C.group / indoor name Enter the line name Characters (Up to 100 bytes,  
Forbidden: “ ' > < : ; , # &)

Air Conditioner No. Air-conditioner number 1 - 128
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 Initialization tool
There is an initialization function to return the system to the factory settings, a function to download setting 
information from the BACnet local server, and a function to update versions of the BACnet local server software.

Starting the Initialization Tool
Use the menu of the Setting File Creation Software for North America or Windows menu to start the Initialization 
Tool.
Menu of the Setting File Creation Software for North America

Fig.318 [Main Menu] screen (Initialization Tool)

Windows menu
Select [Start] > [All Programs] > [Toshiba] > [Setting File Creation Software for North America] > [Initialization Tool].
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Exiting the Initialization Tool
Click the [Close] button, the Exit button, or select the [File] menu then [Exit].

Fig.319 [Main Menu] screen (Close button / Exit button)

Fig.320 [Main Menu] screen (Exit menu)

The exit confirmation dialog box appears.
Click [Yes] to exit, or [No] to cancel exiting.

Fig.321 Exit confirmation dialog box

Click button
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Initializing a system
You can reset a target system to its default settings. All data in the system will be deleted.
Follow the procedure below:

1 Specify an IP address.

2 Select the target system (BMS-STBNxxx).

3 Specify a backup folder. (Fig.323)
A backup folder can be specified before initializing a setting file. If you do not specify a backup folder, the data 
will be backed up to “C:\Documents and Settings\All Users\Application Data\Toshiba Carrier 
Corporation\Initialization Tool\backup” in Windows XP, or “C:\Program Data\Toshiba 
CarrierCorporation\Initialization Tool\backup” in Windows Vista/7. This folder is a hidden folder. To show the 
folder, you need to change the “Folder Options” settings.

4 Use the PING command to check the connection to the target system.

Fig.322 [Initialization Tool] screen

Fig.323 [Browse For Folder] screen
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5 Select the [Tool] menu then [Initialize System].

Fig.324 [Initialization] screen (Initialize System menu)

6 Read the displayed warning message, and select the [Understand these warning messages and 
then perform the processing] checkbox.

Fig.325 [Warning] screen

7 Click the [OK] button.
The initialization starts, and the progress bar appears.

Fig.326 Progress bar

8 If the initialization is completed successfully, the completion dialog box appears.

9 Restart the target system.
Press the reset button, or turn off the power and turn it back on again. When the power is turned off, wait until 
over a minute passes before turning it back on.

Fig.327 Completion dialog box
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Downloading data
You can download setting data from the BACnet local server.
Follow the procedure below:

1 Specify an IP address.

2 Select the target system (BMS-STBNxxx).

3 Specify a folder in which to download. (Fig.329)
Specify a folder in which to save the files downloaded from the BACnet local server. If you do not specify a 
folder, files are saved to "C:\Documents and Settings\All Users\Application Data\Toshiba Carrier 
Corporation\Initialization Tool\backup", in Windows XP or to "C:\Program Data\Toshiba 
CarrierCorporation\Initialization Tool\backup", in Windows Vista/7. This folder is a hidden folder. To show the 
folder, you need to change the "Folder Options" settings.

4 Use the PING command to check the connection to the target system.

Fig.328 [Initialization Tool] screen

Fig.329 [Browse For Folder] screen
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5 Select the [Tool] menu then [Download].

Fig.330 [Initialization] screen (Download menu)

6 The download starts and the progress bar appears.

Fig.331 Progress bar

7 If the download is completed successfully, the completion dialog box appears.

Fig.332 Completion dialog box
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Upgrading
This function upgrades the software of the BACnet local server.

NOTE

An upgraded function cannot be downgraded. The upgrade is performed by connecting the target device to a 
computer containing this software via a network. If the network is disconnected or the power is turned off during 
the upgrade, the system may malfunction.

Perform the following procedure to upgrade:

1 Specify an IP address.

2 Select the target system (BMS-STBNxxx).

3 Specify a backup folder. (Fig.333)
A backup folder can be specified before initializing a setting file. If you do not specify a backup folder, the data 
will be backed up to “C:\Documents and Settings\All Users\Application Data\Toshiba Carrier 
Corporation\Initialization Tool\backup” in Windows XP, or “C:\Program Data\Toshiba Carrier 
Corporation\Initialization Tool\backup” in Windows Vista/7. This folder is a hidden folder. To show the folder, 
you need to change the “Folder Options” settings.

4 Use the PING command to check the connection to the target system.

Fig.333 [Initialization Tool] screen
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Fig.334 [Browse For Folder] screen

5 Select the [Tool] menu then [Up grade].

Fig.335 [Initialization] screen (Up grade menu)

6 The Check Destination Folder screen appears.

7 Click the [Browse] button, and select the folder containing the Up grade data on the displayed 
Browse For Folder screen (Fig.336).

8 Click the [OK] button.

Fig.336 [Check Destination Folder] screen
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9 Read the displayed warning message, and select the [Understand these warning messages and 
then perform the processing] checkbox.

Fig.337 [Warning] screen

10 Click the [OK] button.
The up grade starts, and the progress bar appears.

Fig.338 Progress bar

11 If the Version Up is completed successfully, the completion dialog box appears.
The version of the upgraded software appears.

Fig.339 Completion dialog box
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